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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate and
get a better understanding of the technical data of the signal modules, power supply
modules and interface modules.

Intended Audience

o "F\'-\.
-

This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

4@ Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorized personnel. Failure to
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follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

e In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

B
L

-

L@ Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contrdleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le controleur.

e Reportez-vous au Guide de l'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au controleur.

e La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille M-Duino sont des contréleurs de type ouvert. Il est
nécessaire d'installer |'automate M-Duino dans un boitier, une armoire ou une salle de
contrble électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

e En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Qutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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INDUSTRIAL SHIELDS

1 General Description M-Duino 19R I/0s PLUS Product

1.1  Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and B the shield from above.

s S 11 w v
mnnnnEsEs

B ZONE
A ZONE

A ZONE NE—1——wm
B ZONE &y

, BZONE
-wh ;' AZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

10
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1.2 Zone Distribution

ZONE A » ZONEB
A J A
Communication Relay Shield

The distribution of the different features that provide the M-Duino 19R I/Os PLUS is the
following one:

Shields B Zone

6 Inputs
(6 Digital Inputs,
4 of which can work as Analog
Relay Shield Inpuy
11 Qutputs
(8 Relay Output,
3 Digital/Analog Output)

1.3 A Zone Features

Shield A Zone

(1x) Ethernet
(1x) UsSB
(1x) 12C
o (3x) TTL
Comgw_nllc(;jatlon (1x) RS-232
e (1x) HALF/FULL Duplex RS-485
(1x) SPI external Port
(1x) RTC
(1x) uSD Socket

11
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1.4 Mechanical dimension

1.5 General Features

CONECTABLE PLC ARDUINO 24 VCC M-DUINO

MODEL TYPE GRPS/GSM Controller General Information
Specifications

Fuse Protection (2.5 A) Polarity

Input Voltage 12 to 24 Vdc Srotection
I max. 15A
Size 101x70.1x119.5
Clock Speed 16 MHz
Flash Memory 256 KB of which 8 KB used by boot loader
SRAM 8KB
EEPROM 4KB

12C — Ethernet Port — USB — RS485 — RS232 — SPI — (2x)

RX, TX (Arduino pins) MAX232 — MAX485 — W5500

Communications

: : Only meant for uploading or debugging, NOT ALWAYS Cannot be working in a final
|

USB Consideration! connected as a serial in a project! application

. . Oto10V
An/Dig Input 10 bits Input Impedance: 39K

(0_10 VCC) Separated PCB ground

L. 7 to 24 Vdc
Digital Isolated Input I min: 2 to 12 mA
(24 VCC) Galvanic Isolation

12
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*Interrupt Isolated Input Hs
(24 Vcc)

7 to 24 Vdc
I min: 2 to 12 mA
Galvanic Isolation

Analog Output 8 bits
(0 - 10 Vce)

0to 10 Vdc
I max: 20 mA
Separated PCB Ground

Digital Isolated Output
(24 Vce)

5to 24 Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

| max 24 Vdc: 410 mA

Digital Isolated Output
(Relay)

24 VDC / 220 VAC
I max: 5 A
Galvanic Isolation
Diode Protected for Relay

PWM Isolated Output 8 bits
(24 Vce)

5to 24 Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Expandability

12C — 127 elements — Serial Port RS232 / RS485

*By using this type of signal can no longer use Digital signal (24 Vdc)

13
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2 Technical Specifications:

2.1  General Specifications:

Item

M-Duino PLC Arduino Ethernet 19R I/Os Analog/Digital PLUS

Power supply

voltage DC power supply

12 to 24Vdc ==

Operating

voltage range DC power supply

11.4t0 25.4Vdc ===

Power
consumption DC power supply | 30VAC max.
Power supply 24vdc ===
External voltage
power supply
Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s?in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0°to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 378g max.

14
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2.2

Performance Specification:

Rev. 1: 13-08-2020

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560
Flash Memory 256KB of which 8KB are used by the boot loader
Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz
Clock Speed 16MHz
2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino
Ethernet 19R I/Os Analog/Digital PLUS:

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / , . .
— Graphical symbols 5031 / Direct Indicates that the equipment IS
- Em . suitable for direct current only;
for use on Current . . ;
: to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols . suitable for alternating current
T for use on 5032/ Alternating only; to identify relevant
. Current :
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To _|dent|fy the _control by
for use on which a pulse is started.
: General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
. Ground . - .
equipment 5019 is explicitly required.
IEC 60417 / : . .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Slgnal lamp . )
. lamp(s) is (are) switched on or
equipment

off.
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Medical Devices CE pToagE::r;gc:Jnrg;?;gm?r? ta
92}232%?0 CE Marking applicable European Union
regulations
Gra Iﬁicgaﬁo%bols Indicates a potentially
oAl 0434B / hazardous situation which, if
equibment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Graghlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
; Voltage from dangerous voltages
equipment

3 Precautions

Read this manual before attempting to use the ETHERNET 19R 1/0Os ANALOG/DIGITAL PLUS PLC
and follow its descriptions for reference during operation.

3.1  Arduino Board

The MDUINO PLC ARDUINO ETHERNET BLE 19R 1/Os ANALOG/DIGITAL PLUS includes an
Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this
manual.

Before using the M-DUINO PLC ARDUINO ETHERNET 19R 1/0Os ANALOG / DIGITAL PLUS under
different conditions from what has been specified in this manual or integrating into nuclear
control systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
INDUSTRIAL SHIELDS Ensure that the rating and performance
characteristics of the M-Duino are sufficient for the systems, machines, and equipment, and be

your representative.

sure to provide the systems, machines, and equipment double safety mechanisms. This
manual provides information for programming and operating the M-DUINO.

16
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4 Software interface

Rev. 1: 13-08-2020

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with

Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up

automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Edar lanjuage Bty Enpie Faopies Tt of Ardur

Fattor fort mow
Db e i L] Mnirvety = U felart of 4w

Row srboss gt Arre: |2 esepienn [7]upeas

A Bt Mariage L PLE: 1%/ upems PLBY Mbeaen Cor ey e O e i Fukch gAY ket e el

€ HONs A B AEOWE L aCa WA ot ' e S encun, it

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.
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4. Go to: Tools -> Board: ... -> Boards Manager

e Lt Shanh Touls ooy

e

Pt W O bt et oy
ot Yy 1 D e
o
(et Bt v PSS
A Cada i er w (o b
R Ay
Cotem Cmmare Mg 1o Moy P
L W ALK
S | ey
Soba Lt 111
Ln s W1y
nte 3w
PR
fetew Ivmm
prevesye
A W1
Uat A U
[TYORTIS

5. Search for “industrialshields” on the browser.

@ Boards Manager

=
y Tope |All ~ | industrialshields

industrialshields G
Boards induded in this pacdkage:
ARDBOH Farmaly, M-Ouino family.

Cinling halp
Muora infp

Chme
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools:

There, it can be selected the exact model for every family. In this case M-Duino 19R+.

Also there are some examples of programming in File -> Examples -> M-Duino Family.

Furthermore there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/

19
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5 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino Family uses USB-B cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino Family

- Select the correct M-Duino Board:
M-Duino 19R+

- Select correct port.

&9 sketch_auglda | Arduino 1.8.9

File Edit Sketch Tools Help

Auto Format Ctrl+T

Archive Sketch

Fix Encoding & Reload

vold setup (] Manage Libraries... Ctrl+Shift+
/4 PUT YOl serial Monitor Crls Shift+M

sketch_aug1 4y

Serial Plotter Ctrl+Shift+L

WiFi101 / WiFiNINA Firmware Updater
void loop ()
/{ put yoi Board: "M-Duine WiFi/BT family" »
Medel: "M-Duine 19R+ WiFi/BT" >
Port ! Serial ports
Get Board Info COMT2 (Arduino/Genuino Mega or Mega 2560)

Programmer: "Arduino as ISP" ¥

Burn Bootloader

20
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6 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[_P':".'".'ER Sup PLTI
GBoo |

|—+ 24voe |

| S pe—t e |

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail e
I

-12Vdc / 24vdc —

2.5A

30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent

T --F

protection. There is a LED inductor for power status,

P

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.

21
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7 M-duino Family Pinout

7.1 A Zone connection

Base
(common unit)
A Zone
5 £
pur [a
23 ° g
S c 5 S
oc S c
L O - S
=0 < [
SCL 21 12C/SS
SDA 20 12C/SS
RX0 1 RX0/SS
TXO0 0 TX0/SS
RX1 19 RX1/SS
TX1 18 TX1/SS
X 16 RX2(serial 2)
RX 17 TX2(serial 2)
Z- - RS485
Y+ - RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51 Sl 51 SPI
SCK 52 SPI
Reset Reset SPI
Vin5 Vin5 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd
24Vvdc Power Supply

Rev. 1: 13-08-2020

Configuration Switch* (see section 8 for
configuring the communications.
Enabling communications disables some
1/0s)

Communication Pins

Power supply connectors
(24Vdc — GND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

Base
(common unit)
A Zone
5 £
] o
28| o g
S c = B
o c S c
O = =}
=0 < (I
AREF AREF  |Arduino PIN
IOREF2 | IOREF2 |Arduino PIN
IOREF1 | IOREF1 [|Arduino PIN
7vdc 7Vdc -
GND GND GND
3.3vdc | 3.3vdc [|Arduino PIN
GND GND GND
5vdc 5Vvdc -
GND GND GND

NC
NC
RTC SOL

RTC SDA
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P W
1 S VI
':‘ 13 "i‘
& : 2
nesxt HE Foog ew E ( ¥
1 FIC Battwry x/ /,_ Socket
Ethernet Arduino Power
Connector Reset button
USB programmer Autoreset

connector

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Relay Shield)

B Zone

05 £

c = a

38 | g g
Qs =] ©

=0 = S

o < I

RO.8 37 Relay Out
R0O.7 38 Relay Out
RO0.6 39 Relay Out
R0O.5 40 Relay Out
RO0.4 24 Relay Out
A0.2 6 Analog Out
A0.1" 5 Analog Out
A0.0" 4 Analog Out
GND GND GND
Q0.2" 6 Digital/PWM Out
Qo.1* 5 Digital/PWM Out
Q0.0 4 Digital/PWM Out

GNDCOM - External Isolated Out Gnd
24VCOM - External Isolated Out Vdc

Top Zone

4_.. 3 3 ,,'. '”.4 -
X

Led indicator I/Os state

B Zone

2s £ C

58 o S

Qe e 5

s ¢ = c

o =1 =1
$) B T
<

R0.3 25 Relay Out
RO.2 22 Relay Out
RO.1 23 Relay Out
GND GND GND

10.5 57 Analog/Digital Input
10.4 56 Analog/Digital Input
10.3 55 Analog/Digital Input
10.2 54 Analog/Digital Input
10.1* 8 Interrupt 1 In
(-)10.1 - GND 10.1
10.0* 2 Interrupt O In
(-)10.0 - GND 10.0

See section 8 to select suitable switch configuration for enable these connections.

@ OwptalPyvm
3

an

Anaing
010V

* Note . use coreactly conliguration for

use this signal
(ee user guide)

Rev. 1: 13-08-2020

Relay Outputs

Analog Outputs (Switch
Configuration)

Digital/PWM Outputs
(isolated)

Relay Outputs

Analog/Digital Inputs
Interrupt Inputs (isolated)
Configuration Switch*
(see section 8 to select the

correct configuration for
outputs).
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8 Switch Configuration

8.1 A Zone: Communications

LEFT ZONE
Switch
ON OFF
B ZONE
Pin 3/10.1 10.1 Pin 3
Pin 2/10.0 10.0 Pin 2
uSD & RS-485
D53(SD) - SD
FD RS-485 HD HD FD

OFF ON

SCL/NC
SDA/NC
Rx1/NC
Tx1/NC

® ~cesil)

Pin3/10.6
Pin2/10.5
D53(SD)
FD RS485 HD

OFF ON

Rev. 1: 13-08-2020

4. SCL/12.1: ALWAYS AT OFF POSITION. On the MDUINO PLC ARDUINO ETHERNET 19R 1/Os
ANALOG/DIGITAL PLUS Controller this switch is not connected.

3.SDA/12.0: ALWAYS AT OFF POSITION. On the MDUINO PLC ARDUINO ETHERNET 19R 1/Os
ANALOG/DIGITAL PLUS Controller this switch is not connected.

2. RX1/11.1: Choosing between RX1 or the input 11.6. If this switch is ON, it enables the 11.6
input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6.

1. TX1/11.0: Choosing between TX1 or the input I1.5. If this switch is ON, it enables the 11.5
input and disables the TX1. If this switch is OFF, it enables TX1 and disables 11.5.
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4. Pin 3/10.1: Choosing between Pin 3 or the input 10.1. If this switch is ON, it enables the 10.1
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.1.

3. Pin 2/10.0: Choosing between Pin 2 or the input 10.0. If this switch is ON, it enables the 10.0
input and disables the Pin 2. If this switch is OFF, it enables Pin 3 and disables 10.0

2. D53(SD): ALWAYS AT OFF POSITION. Switch has to be OFF position to enable the Chip
Select of the micro SD card, never ON because in this position is NC (Not Connected).

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables
HD.

LEFT ZONE 2 2 ON
SWITCH ON OFF NC NC
NC - - NC NC
NC - - RTC SCL
RTC SCL RTC -
RTC SDA RTC - RTC SDA

1. RTC SDA: This switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,

whereas if it is in OFF mode it disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter
if it is in ON mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter
if it is in ON mode or OFF mode.
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8.2 B Zone Switches

B ZONE

SWITCH | ON | OFF

NC - -

Q0.2 Q0.2 | A0.2

Q0.1 Q0.1 | A0.1

Q0.0 Q0.0 | A0.0
sl NC
gg. Q0.2
9% Qo1
z&| Qoo

Rev. 1: 13-08-2020

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it

can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with Q0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with A0.X, being X any number of the tables above.
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9 M-Duino Arduino I/0s 5V pins

The MDUINO PLC ARDUINO ETHERNET 19R I/Os ANALOG/DIGITAL PLUS has some of the Mega
board pins available. These pins can be programmed according to Arduino features such as
I/Os operating at 5V or any additional features present in the pins (for example 12C
communication in pins SCL and SDA). As these pins are directly connected to the Arduino Mega
board, they are not as well protected as the normal inputs. These pins are mainly meant to be
used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some
of these pins the configuration switch must be set to OFF position (see section 8) and some
extra considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 Communication switch OFF
TX1 18 Communication switch OFF
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

A part from the switch configuration, there are some special conditions depending on these
5V. Now it is going to be shown the considerations to operate with these pins.

9.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up
inputs.

*IMPORTANT: 12.5 & 12.6 are not pull-up inputs although they are referred to the 12C pins
(switch configuration). There is a “reverse pull-up circuit “that is established in order to have
the same behaviour as the other inputs.

9.2  Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
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debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.

9.3  Serial 1 - RX1/TX1

These pins are only referred to the inputs 11.5/11.6. The RX1/TX1 pins will only be available
if the switch configuration is in OFF position. If not using the Serial 1 interface these pins
can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.

9.4  SPI-MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.

9.5 Pin2/Pin3

These pins are only referred to the inputs 10.0/10.1. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.
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10 A Zone Features: Communications & RTC & uSD
10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects in this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485
Half Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 I2C

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If itis meant to work them as a GPIO at 5V, it has to be considered that they are pull-up inputs.
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10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. The MISO, MOSI
and CLOCK pins are the same for all the connected devices, while the SS pin, conversely, will be
unique for each one.

Function M-Duino connection Mega board pin
MISO 500 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 | 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).

10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SV\II\:I:CH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable
NC - - the 12C wires to the RTC. If they are in OFF mode, the
RTC SCL RTC - Arduino won’t communicate with the RTC.
RTC SDA RTC -

I12C must be enabled in order to communicate with the RTC. See section 11 12C to enable it.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.
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10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the micro SD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the micro SD
can’t be used.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

e

LN Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

"N

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.
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11 Instructions for interconnection between Industrial Shields
controllers

11.1 RS-232 Communication:

M-Duino 19R . ‘Another Industrial )

1/0s PLUS Shields PLC
KRFC.G Ferrie (4 Loops|
Tx! £ AT TR
RS-232 Rx. 5 )\ ‘)\ L )9- Rx RS-232
ELDED CARLE
Ferrde KITA Férrite KITA
GND — h — GND
12724V . T - 1224V

11.2 RS-485 Communication:

11.2.1.1 Half Duplex

M-Duino 19R ‘ Another Industrial :

/0s PLUS | Shields PLC
[KRF C-5 Ferte @ Loses)
A S0 P
RS485 7@ f;:_x_;: Q RS-485
Fesrite KITA Fermte KITA
GND — - } S~ e GND
1224V =" , ; 224V

11.2.2 Full Duplex

M-Duino 19R Another Industrial
I/0Os PLUS Shields PLC |

KRFC.€ Ferriles (4 Loops)

Ferme KITA NELDED CABLE Fermte KITA L
GND - : i e y ~
1224V < , ! AN 1204y
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11.3 Ethernet

KRFC-6 Fernte

Ethemat

M-Duino 19R Another Industrial
I/0s PLUS Shields PLC

Femte KITA Farrse KITA

GND ~_ o~ 3 o~ GND
12728y <~ —\-'- ,@\_/ —AA 124y

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.
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12 1/0 technical details:

Digital Output Waveform:

[l o e——
y

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CHi= S.@al| |5 5,660 M 1.88ms | CHI % 268GEm.)
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Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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13 Typical Connections

( GND
- Si224v

\

~.)

)

SHIELDED CABLE

Ferrite KITA

SHIELDED CABLE

DIGITAL ISOLATED INPUT

— POWER

— o——

Ferrite KIT

0

g

SHIELDED CABLE %

()00
00

A
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SHIELDED CABLE
g{‘ — 224V O’/G
-\ /aND
Ferrite KITA
al *® 0 POWER
AN sead B osraumaoe W
SHIELDED CABLE Prom wew o\
A b
DIGITAUANALOG ID
(Analog)
010V
—M— 0.7
Ferrite KITA
GND
@ ) 9 POWER
2024V [ T

SHIELDED CABLE / s et ey \_
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S

SHIELDED CABLE
SM224v

A oo

0-10v

A,
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& oS
\ /

-

errite KITA

0

12/24V

SHIELDED CABLE

Ferrite Kl

==

0

[A

SHIELDED CABLE

10.7

Downdoad e MOUINO LAYOUT: \
www ndustimishaids com

—

SHIELDED CABLE

—)

GND
7 ALWAYS

&

VOUT = Q/Vde

CONNECTED
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SHIELDED CABLE

Ferrite KITA
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\_‘ A
WAYS
TED
Ferrite KIT/ ®
GND VOUT = Q/ Ve
2124V
ks =
(< L
() ——
SHIELDED CABLE
G&IWI®
OUTPUT /
* Sew the switch
configutarion (ON)
5112724V
GND 3 A
ALWAYS
Jun CONNECTED
() SHIELDED CABLE
\\)I
POWER VOUT = Q/ Vde
E DIGITALIWM OUT

a4

SHIELDEDCABLE/ P o\
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K??\ [Soebo o

o8

by Q/Vee

-5 cOM () A
» ALWAYS

GND
|

SHIELDED CABLE/  wm

_ O Olea Jn
Ferrite KITA “~ L, -~ 05 @
POWER vour=a

E

\z iy
SHIELDED CABLE

RN, * See the switch
) configutarion (OFF)

GND =
A\ 01
(T o)

SHIELDED CABLE

Ferrite KITA o~
GND

= & POWER
224V E ANALOG OUT
SHIELDED CABLE Download the MOUINO LAYOUT:
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension :
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129
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- DIN Rail mounting
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For optimal operation of the product, it must be located in an electrical cabinet with 1K08
mechanical protection. The minimum IP protection degree required is IP56.

43



Ref. IS.MDUINO.19R+ Rev. 1: 13-08-2020

16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 19R I/Os PLUS from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 19R 1/Os PLUS. When configuring the layout of the M-Duino 19R I/Os PLUS inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and high-
energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino 19R +
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I/Os PLUS. Is designed for natural convection cooling. For proper cooling, you must
provide a clearance of at least 25 cm above and below the devices. Also, allow at least 25
cm of depth between the front of the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential for the satisfactory operation
of solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquefied capacitors) must be disposed
of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Rev. 1: 13-08-2020

Revision Number Date Changes
0 30/08/2019 First implementation
1 13/08/2020 Correction of technical details
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitdés de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev. 1: 13-08-2020
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